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This chapter describes Cisco Transport Controller (CTC), the Cisco software interface for the Cisco ONS
15454 SDH. For CTC set up and login information, refer to the Cisco ONS 15454 SDH Procedure Guide.
Chapter topics include:
• CTC Software Delivery Methods
• CTC Installation Overview
• PC and UNIX Workstation Requirements
• ONS 15454 SDH Connection
• CTC Window
• Using the CTC Launcher Application to Manage Multiple ONS Nodes
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• TCC2/TCC2P Card Database
• Software Revert
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CTC Software Delivery Methods
ONS 15454 SDH provisioning and administration is performed using the CTC software. CTC is a Java
application that is installed in two locations; CTC is stored on the Advanced Timing, Communications, and
Control (TCC2) card or the Advanced Timing, Communications, and Control Plus (TCC2P) card, and it is
downloaded to your workstation the first time you log into the ONS 15454 SDH with a new software release.

CTC Software Installed on the TCC2/TCC2P Card
CTC software is preloaded on the ONS 15454 SDH TCC2/TCC2P card; therefore, you do not need to install
software on the TCC2/TCC2P cards. When a new CTC software version is released, use the release-specific
software upgrade guide to upgrade the ONS 15454 SDH software on the TCC2/TCC2P cards.
When you upgrade CTC software, the TCC2/TCC2P cards store the new CTC version as the protect CTC
version. When you activate the new CTC software, the TCC2/TCC2P cards store the older CTC version as
the protect CTC version, and the newer CTC release becomes the working version. You can view the
software versions that are installed on an ONS 15454 SDH by selecting the Maintenance > Software tabs in
node view (Figure 8-1).
Figure 8-1: CTC Software Versions, Node View

CTC Software Delivery Methods
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Select the Maintenance > Software tabs in network view to display the software versions installed on all the
network nodes (Figure 8-2).
Figure 8-2: CTC Software Versions, Network View

CTC Software Installed on the PC or UNIX Workstation
CTC software is downloaded from the TCC2/TCC2P cards and installed on your computer automatically
after you connect to the ONS 15454 SDH with a new software release for the first time. Downloading the
Figure 8-1: CTC Software Versions, Node View
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CTC software files automatically ensures that your computer is running the same CTC software version as
the TCC2/TCC2P cards you are accessing. The computer CTC software files are stored in the temporary
directory designated by your computer's operating system. You can use the Delete CTC Cache button to
remove files stored in the temporary directory. If the files are deleted, they download the next time you
connect to an ONS 15454 SDH. Downloading the Java archive files, called "JAR" files, for CTC takes
several minutes depending on the bandwidth of the connection between your workstation and the ONS 15454
SDH. For example, JAR files downloaded from a modem or a data communication channel (DCC) network
link require more time than JAR files downloaded over a LAN connection.
During network topology discovery, CTC polls each node in the network to determine which one contains
the most recent version of the CTC software. If CTC discovers a node in the network that has a more recent
version of the CTC software than the version you are currently running, CTC generates a message stating
that a later version of the CTC has been found in the network and offers to install the CTC software upgrade.
If you have network discovery disabled, CTC will not seek more recent versions of the software.
Unreachable nodes are not included in the upgrade discovery.
Note: Upgrading the CTC software will overwrite your existing software. You must restart CTC after the
upgrade is complete.

CTC Installation Overview
To connect to an ONS 15454 SDH using CTC, you enter the ONS 15454 SDH IP address in the URL field of
Netscape Communicator or Microsoft Internet Explorer. After connecting to an ONS 15454 SDH, the
following occurs automatically:
1. A CTC launcher applet is downloaded from the TCC2/TCC2P card to your computer.
2. The launcher determines whether your computer has a CTC release matching the release on the ONS
15454 SDH TCC2/TCC2P card.
3. If the computer does not have CTC installed, or if the installed release is older than the
TCC2/TCC2P card's version, the launcher downloads the CTC program files from the TCC2/TCC2P
card.
4. The launcher starts CTC. The CTC session is separate from the web browser session, so the web
browser is no longer needed. Always log into nodes having the latest software release. If you log into
an ONS 15454 SDH that is connected to ONS 15454 SDHs with older versions of CTC, CTC files
are downloaded automatically to enable you to interact with those nodes. The CTC file download
occurs only when necessary, such as during your first login. You cannot interact with nodes on the
network that have a software version later than the node that you used to launch CTC.
Each ONS 15454 SDH can handle up to five concurrent CTC sessions. CTC performance can vary,
depending upon the volume of activity in each session, network bandwidth, and TCC2/TCC2P card load.

PC and UNIX Workstation Requirements
To use CTC in the ONS 15454 SDH, your computer must have a web browser with the correct Java Runtime
Environment (JRE) installed. The correct JRE for each CTC software release is included on the ONS 15454
SDH software CD. If you are running multiple CTC software releases on a network, the JRE installed on the
computer must be compatible with the different software releases.
Table 8-1 shows JRE compatibility with ONS software releases.

CTC Software Installed on the PC or UNIX Workstation
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Table 8-1: JRE Compatibility

ONS Software Release

JRE 1.2.2
Compatible

ONS 15454 SDH Release
Yes
3.3
ONS 15454 SDH Release
No
3.4
ONS 15454 SDH Release
No
4.01
ONS 15454 SDH Release
No
4.1
ONS 15454 SDH Release
No
4.5
ONS 15454 SDH Release
No
4.6
ONS 15454 SDH Release
No
4.7
ONS 15454 SDH Release
No
5.0
ONS 15454 SDH Release
No
6.0
ONS 15454 SDH Release
No
7.0
ONS 15454 SDH Release
No
7.2
ONS 15454 SDH Release
No
8.0
ONS 15454 SDH Release
No
8.5

JRE 1.3
Compatible

JRE 1.4
Compatible

JRE 5.0
Compatible

Yes

No

No

Yes

No

No

Yes

No

No

Yes

No

No

Yes

No

No

Yes

Yes

No

Yes

Yes

No

No

Yes

No

No

Yes

No

No

Yes

Yes

No

Yes

Yes

No

No

Yes

No

No

Yes

1. Software Releases 4.0 and later notify you if an older version of the JRE is running on your PC or UNIX workstation.

Note: To avoid network performance issues, Cisco recommends managing a maximum of 50 nodes
concurrently with CTC. The 50 nodes can be on a single DCC or split across multiple DCCs. Cisco does not
recommend running multiple CTC sessions when managing two or more large networks. To manage more
than 50 nodes, Cisco recommends using Cisco Transport Manager (CTM). If you do use CTC to manage
more than 50 nodes, you can improve performance by adjusting the heap size; see the "General
Troubleshooting" chapter of the Cisco ONS 15454 SDH Troubleshooting Guide. You can also create login
node groups; see the "Connect the PC and Log Into the GUI" chapter of the Cisco ONS 15454 SDH
Procedure Guide.
Table 8-2 lists the requirements for PCs and UNIX workstations. In addition to the JRE, the Java plug-in is
also included on the ONS 15454 SDH software CD.
Table 8-2: CTC Computer Requirements

Area

Requirements

Notes
A faster CPU is recommended if your workstation runs multiple
Processor (PC Pentium 4 processor or
applications or if CTC manages a network with a large number of
only)
equivalent
nodes and circuits.
Table 8-1: JRE Compatibility
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RAM

A minimum of 1 GB is recommended if your workstation runs
512 MB RAM or more multiple applications or if CTC manages a network with a large
number of nodes and circuits.
CTC application files are downloaded from the TCC2/TCC2P to
20 GB hard drive with
your computer. These files occupy around 100MB (250MB to be
Hard drive
100MB of free space
safer) or more space depending on the number of versions in the
required
network.
Operating
Check with the vendor for the latest patch/Service Pack level
System
• PC: Windows
98 (1st and
2nd editions),
Windows ME,
Windows NT
4.0 with
Service Pack
6a, Windows
2000 with
Service Pack
3, or Windows
XP with
Service Pack 1
• Workstation:
Solaris
versions 9 or
10
Java Runtime JRE 5.0
JRE 5.0 is installed by the CTC Installation Wizard included on the
Environment
Cisco ONS 15454 software CD. JRE 5.0 provide enhancements to
CTC performance, especially for large networks with numerous
circuits.
Cisco recommends that you use JRE 5.0 for networks with Software
R8.5 nodes. If CTC must be launched directly from nodes running
software R7.0 or R7.2, Cisco recommends JRE 1.4.2 or JRE 5.0. If
CTC must be launched directly from nodes running software R5.0 or
R6.0, Cisco recommends JRE 1.4.2.If CTC must be launched directly
from nodes running software earlier than R5.0, Cisco recommends
JRE 1.3.1_02.
Web browser
For the PC, use JRE 5.0 with any supported web browser. Cisco
• PC:Internet
recommends Internet Explorer 6.x. For UNIX, use JRE 5.0 with
Explorer 6.x or Netscape 7.x or JRE 1.3.1_02 with Netscape 4.76.
Netscape 7.x
• UNIX
Netscape 4.76 or 7.x is available at the following site:
Workstation: http://channels.netscape.com/ns/browsers/default.jsp
Mozilla 1.7,
Netscape 4.76, Internet Explorer 6.x is available at the following site:
Netscape 7.x http://www.microsoft.com
Cable
User-supplied
Category 5
straight-through cable
with RJ-45 connectors
on each end to connect
the computer directly

Table 8-2: CTC Computer Requirements
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to the ONS 15454
SDH or through a
LAN

ONS 15454 SDH Connection
You can connect to the ONS 15454 SDH in multiple ways. You can connect your PC directly the ONS
15454 SDH (local craft connection) using the RJ-45 port on the TCC2/TCC2P card, to the LAN pins on the
MIC-C/T/P, or by connecting your PC to a hub or switch that is connected to the ONS 15454 SDH. You can
connect to the ONS 15454 SDH through a LAN or modem, and you can establish TL1 connections from a
PC or TL1 terminal. Table 8-3 lists the ONS 15454 SDH connection methods and requirements.
Table 8-3: ONS 15454 SDH Connection Methods

Method

Local
craft

Description
Refers to onsite network connections between the CTC
computer and the ONS 15454 SDH using one of the
following:
• The RJ-45 (LAN) port on the TCC2/TCC2P card
• The LAN pins on the ONS 15454 SDH
MIC-C/T/P FMEC
• A hub or switch to which the ONS 15454 SDH is
connected

Corporate Refers to a connection to the ONS 15454 SDH through a
LAN
corporate or network operations center (NOC) LAN.

TL1

Remote

Requirements
• If you do not use Dynamic
Host Configuration Protocol
(DHCP), you must change
the computer IP address,
subnet mask, and default
router, or use automatic host
detection.
• The ONS 15454 SDH must
be provisioned for LAN
connectivity, including IP
address, subnet mask,
default gateway.
• The ONS 15454 SDH must
be physically connected to
the corporate LAN.* The
CTC computer must be
connected to the corporate
LAN that has connectivity to
the ONS 15454 SDH.

Refers to a connection to the ONS 15454 SDH using TL1
rather than CTC. TL1 sessions can be started from CTC, or
you can use a TL1 terminal. The physical connection can
be a craft connection, corporate LAN, or a TL1 terminal. Refer to the Cisco ONS 15454 SDH and Cisco ONS 15600
SDH TL1 Reference Guide for more information about
TL1.

Refers to a connection made to the ONS 15454 SDH using
a modem.

ONS 15454 SDH Connection

• A modem must be connected
to the ONS 15454 SDH.
• The modem must be
provisioned for ONS 15454
SDH. To run CTC, the
modem must be provisioned
for Ethernet access.
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CTC Window
The CTC window appears after you log into an ONS 15454 SDH (Figure 8-3). The window includes a menu
bar, toolbar, and a top and bottom pane. The top pane provides status information about the selected objects
and a graphic of the current view. The bottom pane provides tabs and subtabs to view ONS 15454 SDH
information and perform ONS 15454 SDH provisioning and maintenance. From this window you can display
three ONS 15454 SDH views: network, node, and card.
Figure 8-3: Node View (Default Login View)

Node View
Node view, shown in Figure 8-3, is the first view open after you log into an ONS 15454 SDH. The login
node is the first node shown, and it is the "home view" for the session. Node view allows you to view and
manage one ONS 15454 SDH node. The status area shows the node name; IP address; session boot date and
time; number of Critical (CR), Major (MJ), and Minor (MN) alarms; the name of the current logged-in user;
and the security level of the user; software version; and the network element default setup.
CTC Card Colors
The graphic area of the CTC window depicts the ONS 15454 SDH shelf assembly. The colors of the cards in
the graphic reflect the real-time status of the physical card and slot (Table 8-4).
Table 8-4: Node View Card Colors

Card Color
Status
Gray
Slot is not provisioned; no card is installed.
Violet
Slot is provisioned; no card is installed.
White
Slot is provisioned; a functioning card is installed.
CTC Window
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Yellow
Slot is provisioned; a Minor alarm condition exists.
Orange
Slot is provisioned; a Major alarm condition exists.
Red
Slot is provisioned; a Critical alarm exists.
The colors of the Front Mount Electrical Connection (FMEC) cards reflect the real-time status of the physical
FMEC cards. Table 8-5 lists the FMEC card colors. The FMEC ports shown in CTC do not change color.
Note: You cannot preprovision FMECs.
Table 8-5: Node View FMEC Color

Upper Shelf FMEC Color
Status
White
Functioning card is installed.
Yellow
Minor alarm condition exists.
Orange (Amber)
Major alarm condition exists.
Red
Critical alarm exists.
Port color in both card and node view indicates the port service state. Table 8-6 lists the port colors and their
service states. For more information about port service states, see Administrative and Service States.
Table 8-6: Node View Card Port Colors and Service States

Port
Color

Service State

Description

Port is in a loopback state. On the card in node view, a line between
ports indicates that the port is in terminal or facility loopback (see Figure
8-4 and Figure 8-5). Traffic is carried and alarm reporting is suppressed.
Blue Locked-enabled,loopback
Raised fault conditions, whether or not their alarms are reported, can be
retrieved on the CTC Conditions tab or by using the TL1 RTRV-COND
command.
Port is out-of-service for maintenance. Traffic is carried and loopbacks
are allowed. Alarm reporting is suppressed. Raised fault conditions,
whether or not their alarms are reported, can be retrieved on the CTC
Conditions tab or by using the TL1 RTRV-COND command. Use
Locked-enabled,
Blue
maintenance
Locked-enabled,maintenance for testing or to suppress alarms
temporarily. Change the state to Unlocked-enabled;
Locked-enabled,disabled; or Unlocked-disabled,automaticInService
when testing is complete.
The port is out-of-service and unable to carry traffic. Loopbacks are not
Gray Locked-enabled,disabled
allowed in this service state.
The port is fully operational and performing as provisioned. The port
Green Unlocked-enabled
transmits a signal and displays alarms; loopbacks are not allowed.
Violet Unlocked-disabled,
The port is out-of-service, but traffic is carried. Alarm reporting is
automaticInService
suppressed. The node monitors the ports for an error-free signal. After an
error-free signal is detected, the port stays in this state for the duration of
the soak period. After the soak period ends, the port service state
changes to Unlocked-enabled.
Raised fault conditions, whether or not their alarms are reported, can be
retrieved on the CTC Conditions tab or by using the TL1 RTRV-COND
command. The AINS port will automatically transition to
Unlocked-enabled when a signal is received for the length of time
Table 8-4: Node View Card Colors
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provisioned in the soak field.
Figure 8-4: Terminal Loopback Indicator

Figure 8-5: Facility Loopback Indicator

Card and Port States
The wording on a lower-shelf card in node view shows the status of a card (Active, Standby, Loading, or Not
Provisioned). Table 8-7 lists the card states.
Table 8-7: Node View Card States

Lower Shelf Card Status
Description
Sty
Card is in standby.
Act
Card is active.
NP
Card is not present.
Ldg
Card is resetting.
The graphics on a port in node view show the state of a port (diagonal lines or loop graphics). Table 8-8 lists
the port graphic and their description.
Table 8-8: Node View Port Graphics

Lower Shelf Port
Description
Graphics
Multiple diagonal lines on
Port is in service and card was reset.
port
Port is in service and has a loopback provisioned in Card View > Maintenance >
Loop graphic on port
Loopback tabs.
Node View Card Shortcuts
If you move your mouse over cards in the graphic, popups display additional information about the card
including the card type; the card status (active or standby); the type of alarm, such as Critical, Major, and
Minor (if any); and the alarm profile used by the card. Right-click a card to reveal a shortcut menu, which
you can use to open, reset, or delete a card. Right-click a slot to preprovision a card (that is, provision a slot
before installing the card).
Node View Tabs
Table 8-9 lists the tabs and subtabs available in the node view.
Table 8-9: Node View Tabs and Subtabs

Tab
Alarms

Description

Table 8-6: Node View Card Port Colors and Service States

Subtabs
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Lists current alarms (CR, MJ, MN) for the node and
updates them in real time.
Conditions Displays a list of standing conditions on the node.
Provides a history of node alarms including date,
type, and severity of each alarm. The Session subtab
History
displays alarms and events for the current session.
Session, Node
The Node subtab displays alarms and events
retrieved from a fixed-size log on the node.
Circuits
Creates, deletes, edits, and maps circuits.
General, Ether Bridge, Network, OSI,
MS-SPRing, Protection, Security,
Provisioning Provisions the ONS 15454 SDH node.
SNMP, Comm Channels, Timing, Alarm
Profiles, Cross-Connect, Defaults,
WDM-ANS
Provides inventory information (part number, serial
number, CLEI codes) for cards installed in the node. Inventory
Allows you to delete and reset cards.
Database, Ether Bridge, Network, OSI,
MS-SPRing, Protection, Software,
Maintenance Performs maintenance tasks for the node.
Cross-Connect, Overhead XConnect,
Diagnostic, Timing, Audit, Test Access,
DWDM

Network View
Network view allows you to view and manage ONS 15454 SDHs that have DCC connections to the node that
you logged into and any login node groups you selected (Figure 8-6).
Figure 8-6: CTC Network View

Table 8-9: Node View Tabs and Subtabs
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Note: Nodes with DCC connections to the login node do not appear if you checked the Disable Network
Discovery check box in the Login dialog box.
The graphic area displays a background image with colored ONS 15454 SDH icons. A Superuser can set up
the logical network view feature, which enables each user to see the same network view. Selecting a node or
span in the graphic area displays information about the node and span in the status area.
CTC Node Colors
The color of a node in network view, shown in Table 8-10, indicates the node alarm status.
Table 8-10: Node Status Shown in Network View

Color

Alarm Status

Green
No alarms
Yellow
Minor alarms
Orange
Major alarms
Red
Critical alarms
Gray with
Node initializing for the first time (CTC displays Unknown# because CTC has not
Unknown#
discovered the name of the node yet)
Network View Tabs
Table 8-11 lists the tabs and subtabs available in network view.
Table 8-11: Network View Tabs and Subtabs

Tab
Alarms
Conditions
History
Circuits

Provisioning

Maintenance

Description
Lists current alarms (CR, MJ, MN) for the network and updates
them in real time.
Displays a list of standing conditions on the network.
Provides a history of network alarms including date, type, and
severity of each alarm.
Creates, deletes, edits, filters, and searches for network circuits.

Subtabs
-

Security, Alarm
Profiles, MS-SPRing,
Provisions security, alarm profiles, MS-SPRings, overhead circuits,
Overhead Circuits,
server trails, and loads/manages a VLAN database
Server Trails, VLAN
DB Profile
Displays the working and protect software versions and allows
software to be downloaded, retrieves Open Shortest Path First
Software, Diagnostic,
(OSPF) node information, and displays the list of automatic power APC
control (APC) domains for a network

DCC Links
The lines show DCC connections between the nodes. DCC connections can be green (active) or gray (fail).
The lines can also be solid (circuits can be routed through this link) or dashed (circuits cannot be routed
through this link).
There are four possible combinations for the appearance of DCCs: green/solid, green/dashed, gray/solid, or
gray/dashed. DCC appearance corresponds to the following states: active/routable, active/nonroutable,
failed/routable, or failed/nonroutable. Circuit provisioning uses active/routable links.
Figure 8-6: CTC Network View
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Link Consolidation
CTC provides the ability to consolidate the DCC, general communications channel (GCC), optical transport
section (OTS), provisionable patchcord (PPC), and server trail links shown in the network view into a more
streamlined view. Link consolidation allows you to condense multiple inter-nodal links into a singular link.
The link consolidation sorts links by class, meaning that all DCC links are consolidated together, for
example.You can access individual links within consolidated links using the right-click shortcut menu.
Each link has an associated icon (Table 8-12).
Table 8-12: Link Icons

Icon

Description
DCC icon
GCC icon
OTS icon
PPC icon
Server Trail icon

Note: Link consolidation is only available on non-detailed maps. Non-detailed maps display nodes in icon
form instead of detailed form, meaning the nodes appear as rectangles with ports on the sides. Refer to the
Cisco ONS 15454 SDH Procedure Guide for more information about consolidated links.

Card View
Card view provides information about individual ONS 15454 SDH cards (Figure 8-7). Use this window to
perform card-specific maintenance and provisioning. A graphic showing the ports on the card is shown in the
graphic area. The status area displays the node name, slot, number of alarms, card type, equipment type, and
the card status (active or standby), card state if the card is present, or port state (Table 8-6). The information
that appears and the actions you can perform depend on the card. For more information about card service
states, see Administrative and Service States.
Figure 8-7: CTC Card View

Link Consolidation
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Note: CTC provides a card view for all ONS 15454 SDH cards except the TCC2, TCC2P, XC10G,
XC-VXL-10G, XC-VXL-2.5G, XC-VXC-2.5G, and SC-VSC-10G cards. Provisioning for these common
control cards occurs at the node view; therefore, no card view is necessary.
Use the card view tabs and subtabs, shown in Table 8-13, to provision and manage the ONS 15454 SDH. The
subtabs, fields, and information shown under each tab depend on the card type selected. The Performance tab
is not available for the AIC-I card.
Table 8-13: Card View Tabs and Subtabs

Tab

Description
Lists current alarms (CR, MJ,
Alarms
MN) for the card and updates
them in real time.
Displays a list of standing
Conditions
conditions on the card.
Provides a history of card alarms
History
including date, object, port, and
severity of each alarm.
Creates, deletes, edits, and
Circuits
searches for circuits.
Provisioning Provisions an ONS 15454 SDH
card.

Figure 8-7: CTC Card View

Subtabs
Session (displays alarms and events for the current
session), Card (displays alarms and events retrieved from a
fixed-size log on the card)
Circuits
DS-N and STM cards: Line, Line Thresholds (different
threshold options are available for electrical and optical
cards), Elect Path Thresholds, SDH Thresholds, VC4,
Alarm Profiles
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Ethernet cards (subtabs depend on the card type): Line,
Line Thresholds, Electrical Path Thresholds, SDH
Thresholds, Port, RMON Thresholds, VLAN, Card, Alarm
Profiles
DS-N and STM cards: Loopback, ALS, Info, Protection,
Path Trace, Bandwidth, AINS Soak
Maintenance

Performs maintenance tasks for
the card.

Performance

Performs performance monitoring
for the card.

Inventory

Displays an Inventory screen of
the ports (TXP and MXP cards
only).

Ethernet cards (subtabs depend on the card type): Path
Trace, Loopback, VC4/VC LO Allocation, AINS Soak,
Ether Port Soak, RPR Span Soak
DS-N and STM cards: no subtabs
Ethernet cards: Statistics, Utilization, History
-

Print or Export CTC Data
You can use the File > Print or File > Export options to print or export CTC provisioning information for
record keeping or troubleshooting. The functions can be performed in card, node, or network views. The File
> Print function sends the data to a local or network printer. File > Export exports the data to a file where it
can be imported into other computer applications, such as spreadsheets and database management programs.
Whether you choose to print or export data, you can choose from the following options:
• Entire frame-Prints or exports the entire CTC window including the graphical view of the card, node,
or network. This option is available for all windows.
• Tabbed view-Prints or exports the lower half of the CTC window containing tabs and data. The
printout includes the selected tab (on top) and the data shown in the tab window. For example, if you
print the History window tabbed view, you print only history items appearing in the window. This
option is available for all windows.
• Table Contents-Prints CTC data in table format without graphical representations of shelves, cards,
or tabs. This option does not apply to all windows. For details, refer to the print or report tasks in the
Cisco ONS 15454 Procedure Guide.
The Table Contents option prints all the data contained in a table with the same column headings.
For example, if you print the History window Table Contents view, you print all data included in the
table whether or not items appear in the window.

Using the CTC Launcher Application to Manage Multiple ONS Nodes
The CTC Launcher application is an executable file, StartCTC.exe, that is provided on Software Release 8.5
CDs for Cisco ONS products. You can use CTC Launcher to log into multiple ONS nodes that are running
CTC Software Release 3.3 or higher, without using a web browser.
CTC Launcher provides two connection options. The first option is used to connect to ONS NEs that have an
IP connection to the CTC computer. The second option is used to connect to ONS NEs that reside behind
third party, OSI-based gateway network elements (GNEs). For this option, CTC Launcher creates a TL1
tunnel to transport the TCP traffic through the OSI-based GNE.
The TL1 tunnel transports the TCP traffic to and from ONS end network elements (ENEs) through the
Table 8-13: Card View Tabs and Subtabs
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OSI-based GNE. TL1 tunnels are similar to the existing static IP-over-CLNS tunnels, GRE and Cisco IP, that
can be created at ONS NEs using CTC. (Refer to the Cisco ONS product documentation for information
about static IP-over-CLNS tunnels.) However, unlike the static IP-over-CLNS tunnels, TL1 tunnels require
no provisioning at the ONS ENE, the third-party GNE, or DCN routers. All provisioning occurs at the CTC
computer when the CTC Launcher is started.
Figure 8-8 shows examples of two static IP-over-CLNS tunnels. A static Cisco IP tunnel is created from ENE
1 through other vendor GNE 1 to a DCN router, and a static GRE tunnel is created from ONS ENE 2 to the
other vender, GNE 2. For both static tunnels, provisioning is required on the ONS ENEs. In addition, a Cisco
IP tunnel must be provisioned on the DCN router and a GRE tunnel provisioned on GNE 2.
Figure 8-8: Static IP-Over-CLNS Tunnels

Figure 8-9 shows the same network using TL1 tunnels. Tunnel provisioning occurs at the CTC computer
when the tunnel is created with the CTC Launcher. No provisioning is needed at ONS NEs, GNEs or routers.
Figure 8-9: TL1 Tunnels

Using the CTC Launcher Application to Manage Multiple ONS Nodes
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TL1 tunnels provide several advantages over static IP-over-CLNS tunnels. Because tunnel provisioning is
needed only at the CTC computer, they are faster to set up. Because they use TL1 for TCP transport, they are
more secure. TL1 tunnels also provide better flow control. On the other hand, IP over CLNS tunnels require
less overhead and usually provide a slight performance edge over TL1 Tunnels (depending on network
conditions). TL1 tunnels do not support all IP applications such as SNMP and RADIUS Authentication.
Table 8-14 shows a comparison between the two types of tunnels.
Table 8-14: TL1 and Static IP-Over-CLNS Tunnels Comparison

Category

Static
IP-Over-CLNS

TL1
Tunnel

Comments

Requires provisioning at ONS NE, GNE, and DCN
Simple
routers. For TL1 tunnels, provisioning is needed at CTC
computer.
Static tunnels generally provide better performance than
TL1 tunnels, depending on TL1 encoding used.
Average to
LV+Binary provides the best performance. Other
good
encoding will produce slightly slower TL1 tunnel
performance.
TL1 tunnels do not support SNMP or RADIUS Server
No
IP applications.
Only the static IP-over-CLNS tunnels meet ITU
No
standards. TL1 tunnels are new.

Setup

Complex

Performance

Best

Support all IP
applications

Yes

ITU Standard

Yes

Tunnel traffic
control

Good

Very good Both tunnel types provide good traffic control

Security setup

Complex

No setup
needed

Static IP-over-CLNS tunnels require careful planning.
Because TL1 tunnels are carried by TL1, no security
provisioning is needed.

Not
possible

A potential exists to breach a DCN from a DCC using
IP. This potential does not exist for TL1 tunnels.

Potential to breach
DCN from DCC
Possible
using IP.
Figure 8-9: TL1 Tunnels
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IP route
management

Expensive

Flow control
Weak
Bandwidth sharing
among multiple
Weak
applications

For static IP-over-CLNS tunnels, route changes require
Automatic manual provisioning at network routers, GNEs, and
ENEs. For TL1 tunnels, route changes are automatic.
Strong
TL1 tunnels provide the best flow control.
Best

TL1 tunnels are terminated when the CTC session ends.
Tunnel lifecycle
Fixed
Static IP-over-CLNS tunnels exist until they are deleted
in CTC.
TL1 tunnel specifications and general capabilities include:
CTC
session

• Each tunnel generally supports between six to eight ENEs, depending on the number of tunnels at the
ENE.
• Each CTC session can support up to 32 tunnels.
• The TL1 tunnel database is stored locally in the CTC Preferences file.
• Automatic tunnel reconnection occurs when the tunnel goes down.
• Each ONS NE can support at least 16 concurrent tunnels.

TCC2/TCC2P Card Reset
You can reset the ONS 15454 SDH TCC2/TCC2P card by using CTC (a soft reset) or by physically reseating
a TCC2/TCC2P card (a hard reset). A soft reset reboots the TCC2/TCC2P card and reloads the operating
system and the application software. Additionally, a hard reset temporarily removes power from the
TCC2/TCC2P card and clears all buffer memory.
You can apply a soft reset from CTC to either an active or standby TCC2/TCC2P card without affecting
traffic. If you need to perform a hard reset on an active TCC2/TCC2P card, put the TCC2/TCC2P card into
standby mode first by performing a soft reset.
Note: When a CTC reset is performed on an active TCC2/TCC2P card, the AIC-I card goes through an
initialization process and also resets because the AIC-I card is controlled by the active TCC2/TCC2P.
Note: To avoid a node IP and secure IP ending up in the same domain after restoring a database, ensure that
the node IP stored in the database differs in domain from that of the node in repeater mode. Also, after
restoring a database, ensure that the node IP and secure IP differ in domain.

TCC2/TCC2P Card Database
When dual TCC2/TCC2P cards are installed in the ONS 15454 SDH, each TCC2/TCC2P card hosts a
separate database; therefore, the protect card's database is available if the database on the working
TCC2/TCC2P fails. You can also store a backup version of the database on the workstation running CTC.
This operation should be part of a regular ONS 15454 SDH maintenance program at approximately weekly
intervals, and should also be completed when preparing an ONS 15454 SDH for a pending natural disaster,
such as a flood or fire.
A database may be restored in two ways, partial or complete. A partial database restore operation restores
only the provisioning data. A complete database restore operation restores both system and provisioning data.
For more information on restoring a database, refer to the Cisco ONS 15454 SDH Procedure Guide.

Table 8-14: TL1 and Static IP-Over-CLNS Tunnels Comparison
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Note: The following parameters are not backed up and restored: node name, IP address, mask and gateway,
and Internet Inter-ORB Protocol (IIOP) port. If you change the node name and then restore a backed up
database with a different node name, the circuits map to the new node name. Cisco recommends keeping a
record of the old and new node names.

Software Revert
When you click the Activate button after a software upgrade, the TCC2/TCC2P copies the current working
database and saves it in a reserved location in the TCC2/TCC2P flash memory. If you later need to revert to
the original working software load from the protect software load, the saved database installs automatically.
You do not need to restore the database manually or recreate circuits.
Note: The TCC2/TCC2P card does not carry any software earlier than Software R4.0. You will not be able to
revert to a software release earlier than Software R4.0 with TCC2/TCC2P cards installed.
The revert feature is useful if a maintenance window closes while you are upgrading CTC software. You can
revert to the protect software load without losing traffic. When the next maintenance window opens,
complete the upgrade and activate the new software load.
Circuits created and provisioning done after a software load is activated (upgraded to a higher software
release) will be lost with a revert. The database configuration at the time of activation is reinstated after a
revert. This does not apply to maintenance reverts (for example, 4.6.2 to 4.6.1), because maintenance releases
use the same database.
To perform a supported (non-service-affecting) revert from Software R8.5, the release you want to revert to
must have been working at the time you first activated Software R8.5 on that node. Because a supported
revert automatically restores the node configuration at the time of the previous activation, any configuration
changes made after activation will be lost when you revert the software. Downloading Release 8.5 a second
time after you have activated a new load ensures that no actual revert to a previous load can take place (the
TCC2/TCC2P will reset, but will not be traffic affecting and will not change your database).

TCC2/TCC2P Card Database
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